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PART-6

CHAPTER-1
WORKING OF COMPUTER

(v) 2. (v) 3. (iv) 4. (ii)

(iii)

(F) 2. (T) 3. (F) 4. (T)
(T)

Speakers 2. Plotters
Dot-Matrix 4. Secondary
RAM 6. Mouse

Input devices are the devices that accept the
instructions and data from the user.

There are two types of storage devices.

The devices which guide in displaying and
delivering the results are known as output
devices. For example- (i) Monitor, (i1) Printer

The basic components of a CPU are—Control
Unit and Arithmetic Logic Unit.

The fundamental operation performed by a
computer system are-

(1) Receivinginput

(11) Processing input

(111) Giving output

(iv) Storing data and information before and

after the processing
(iv) 2. (V)
(vi) 4. (iii)

(ii) 6. (I)
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In The Computer Lab

A. 1.
3.
5.

B. Doityourself.

A. 1.
4,
B. I
4,
C. I
3.
5.
D. 1.
2.
3.
4,
5.

Joystick 2. Barcode Reader
Electronic Light Pen 4. Flatbed Scanner
Graphic Tablet 6. Hard disk
CHAPTER-2

COMPUTER LANGUAGES
(i1) 2. (iii) 3. (D
(i1) 5. (iv)
(F) 2. (F) 3. ()
(F) 5..(1)
Assembly 2. High
Machine 4. Java

LOGO

Assembly language is the language that uses

mnemonic codes and symbolic addresses.

Two advantages of high level language-

(1) Commands are written in simple English
language.

(i1) Programs require less time and effort for
coding.

Compiler is a complex software which converts

high level language programs into machine

language.

We need to convert our language into machine

language because it is the only language that the

computer understands.

High level language is used to write programs in

simple English words.
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In The Computer Lab
A. Do it yourself
TEST PAPER-1
A. (1) Touch Screen
(11) Graphic Tablet
(111) Keyboard
(iv) Mouse
(v) Joystick
(vi) Flatbed Scanner
B. Do it yourself.
C. (1) Compact Disc Read-Write
(i1) Digital Video/Versatile Disc
(ii1) Compact Disk-Read only memory
(iv) Beginners All Purpose Symbolic Instruction
Code
(v) COmmon Business Oriented Language
(vi) FORmula TRANslator

CHAPTER-3
MORE ON MS WINDOWS 7

A. 1. (d) 2. (¢ 3. (b)

4. (¢ 5. (a)
B. 1. (1) 2. (F) 3. (D

4. (F) 5. (D)
C. 1. Back

2. Two

3. Transparent

4. Systemand Security

5. Address Bar
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The Control Panel has been loaded with many
icons which are used to manage various
resources and operate the computer system.

Step 1- Open control panel.

Step 2- Click on the appearance and
personalization option.

Step 3- Click on taskbar and start menu.

Ste 4- Check the Auto-hide the taskbar potion in
the taskbar and start menu properties dialog
box.

Changing the Mouse Button settings-

Step 1- Open the control panel and click on the
hardware and sound option.

Step 2- Click on the mouse option in devices &
Printers.

Step 3- Change the settings in the mouse
properties dialog box.

Step 4- Click on apply and then click ok.
Changing the appearance of windows-

Step 1- Open the Control Panel and click on
Appearance and Personalization option.

Step 2- Out of a list of options, click
Personalization option.

Step 3- Select the Theme of your choice and
click to apply it.

Resizing a window-

Step 1- Right click on the top left corner of a
window.

Step 2- Click on Size option from the menu.
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Step 3- Use the Arrow keys to resize the
window to the required size.

Step 4- Press the Enter key after completing the
task.

In The Computer Lab
A. Doityourself.

e O el e

CHAPTER-4
MORE ABOUT MS WORD 2010
(i1) 2. (iii) 3. (iii)
(ii1) 5. (iv)
(F) 2. (F) 3. (D
(F) 5. (D)
Replace
Search
Mail Merge
Vertical Space

Right- clicking

Inserting a hyperlink-

Step 1- Select the text in which the hyperlink is
to be placed.

Step 2- Click on the Insert tab on the Ribbon.
Step 3- Click on the Hyperlink option in Links
group. An Insert Hyperlink dialog box appears
which contains many options for creating a
link.

Step 4- Type address of a website or click on
any existing file to create a link. We can also
link content through e-mail address.

[6]



Step 5- Click on the OK button. A hyperlink has
been inserted now.

2. Line spacing is the vertical space between lines

of a text. Select the paragraph to set line
spacing. Click on the Home tab. Click on Line
Spacing in the Paragraph group and select the
desired spacing from the list.

3. Page margins are spaces between the edges of

paper and text.

4.  Applying Drop Cap-

Step 1- Click in the paragraph which you want
to be started with a Drop Cap letter

Step 2- Click on the Insert tab.
Step 3- Click on the Drop Cap from the Text
group.

5. The Microsoft Office help button is used to

seek help about any feature of MS Word.

In The Computer Lab
A. Do it yourself.

B.
C.

Do it yourself.
Do it yourself.

CHAPTER-5
KINDS OF COMPUTER SOFTWARE

1. (i) 2. (iii) 3. (ii)

4. (iii) 5. (iv)

1. (F) 2. (T) 3. (F)

4. (F) 5. (T)

(7]



1. System 2.  Multi-user
3. Singleuser 4. MacOS
5. DOS
I. (i) Microsoft Windows
(il)) MACOS

2. GUI- Graphic User Interface
CUI- Character User Interface

3. Operating system is one of the most popular
softwares which enables the computer
hardwares to communicate with each other and
makes them work together.

4. InaMulti-user operating system, more than one
person can work at a time.

5. (1) Corel DRAW Graphics Suite
(i1) AdobeCS

In The Computer Lab

SOR P

Doityourself.

Do ityourself.
Doityourself.

(1) Microsoft Office Word
(11) Microsoft Office Excel
(iii) Corel DRAW

(iv) 3D MAX

TEST PAPER-2

Do ityourself.
(1) Minimize Button (ii)) Maximize Button
(ii1) Close Button (iv)  Start Button

(v) Computer Button (vi) Recycle Bin Button
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C. Doityourself.
TEST PAPER-3

A. 1. (1) 2. (iii) 3. (1) 4. (ii)
B. 1. (F) 2. (T) 3. (D)
4. (1) 5. (F) 6. (T)
C. 1. Brain 2. Programming
3. Address bar 4. MACOS
5. DOS
D. 1. Assembly language is the language that uses

mnemonic codes and symbolic addresses.

2. The Control Panel has been loaded with many
icons which are used to manage various
resources and operate the computer system.

3. Steps forapplying Drop Cap-

Step 1- Click in the paragraph which you want
to be started with a Drop Cap letter

Step 2- Click on Insert tab.

Step 3- Click on the Drop Cap from the Text
group.

4. The basic components of a CPU are Control
Unit and Arithmetic Logic Unit.

5. GUI- Graphic User Interface
CUI- Character User Interface

CHAPTER-6
MORE ABOUT MS POWERPOINT 2010

B. 1. (¢ 2. (b) 3. (b)
4. (d) 5. (d)

B. 1. (F) 2. (F) 3. (F)
4. (F) 5. (T)

9]
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Unique

Smart Art

Three

Music

Edit

Inserting a table in a slide-

Step 1- Select a Slide Layout including a table
placeholder. For example: Title and Content.

Step 2- Click on the Table Placeholder. The
Insert Table dialog box opens up.

Step 3- Enter the required number of rows and
columns. Click on the OK button.

Step 4- Fill the required data in the empty table
that appears.

Toresize a picture in power paint-

Step 1- Select the picture you want to resize.
Step 2- Click and drag one of the four dots
which appear at each corner of the picture.

Step 3- Release the mouse when you are done
resizing the picture.

Inserting a table in a slide-

Step 1- Select a Slide Layout including a table
placeholder. For example: Title and Content.

Step 2- Click on the Table Placeholder. The
Insert Table dialog box opens up.

Step 3- Enter the required number of rows and
columns. Click on the OK button.

Step 4- Fill the required data in the empty table
that appears.

[10]



Animating a slide-

Step 1- Select the slide in which transition is to
be applied.

Step 2- Click on the Transitions tab.

Step 3- Click on the More button in Transition
to This Slide group. We can see a gallery
containing various transition effects.

Step 4- Click to apply the required effect after
checking the preview effect of the slide. You
can modify transition, set speed and sounds, as
required from Transition to This Slide group.
Step 5- Click on Preview from Design tab for
slide preview. Click the Slide Show button on
status bar and see the slide containing transition
effects.

Animations are used to make presentations
attractive and more appealing. You can use the
slide transition option to check how and when
the slides appear during slide show.

In The Computer Lab
A. Do it yourself.

A.

B.

CHAPTER-7
FORMATTING IN MS POWERPOINT 2010
(i1) 2. (i) 3. (iv)
(1) 5. (i)
(F) 2. (F) 3. (F)
(T) 5. (F)
Justify 2. Font Size
Strike through 4. Clear all formatting
Indenting

Al

[11]
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Shadow Button is used in order to apply shadow
effect to the text.

Three toggle buttons used in MS Powerpoint
2010-

() Bold

(1) Italic

(111) Underline

Changing Color Scheme-

Step 1- Open any presentation. Click on the

Design tab.

Step 2- Click on the Colors option and apply

any color scheme. Observe the effect.

Alignment refers to the placement of text in a

slide. Types—

(1) Left Alignment- It aligns the text towards
the left margin.

(11) Right Alignment- It aligns the text towards
the right margin.

Indent feature moves a paragraph or the first

line to a specific number of places from the left

or right margin.

(iii) 2. (V) 3. (iv)
(i) 5. (i)

SCHEME

ALIGNMENT

UNDERLINE

JUSTIFY

In The Computer Lab
Do ityourself.

[12]
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TEST PAPER-4

Do ityourself.

Do ityourself.

1.
3.
5.

o O S el e

(iii) 2. (W)
(iv) 4. (@)
(i)

CHAPTER-8

INTRODUCTION TO MS EXCEL 2010

(iv) 2. (i) 3. (1)

(i1) 5. (1)

(F) 2. (F) 3. (F)

(T) 5. (F)

Esc

Row

Ctrl+ Space Bar

Name

Spreadsheet

Ctrl + A 1s the keyboard shortcut to select an
entire worksheet.

Two softwares used to create spreadsheets-

(1) MSExcel

(i) Lotus 123

15 is the default row height and 8.43 is the
default common width.

Inserting a row-

Step 1- Select the row below to the place where
anew row is to be inserted.

Step 2- Click on the Home tab from the Ribbon.

Step 3- Click on Insert from the Cells group. We

see adrop down list.
[13]



Step 4- Click on the Insert Sheet Rows option
and insert a new row.

In MS Excel worksheet, there are 16,834
columns and 10,48, 576 rows by default.

In The Computer Lab
A. Do it yourself.

B.

Do ityourself.
CHAPTER-9

FORMULAE IN MS EXCEL 2010
1. (iii) 2. (1) 3. (iii)
4. (i) 5. (iv)
1. (F) 2. (F) 3. (F)
4. (F) 5. (F)
1. Formula 2. Cell
3. Strings 4. Logical
5. Sorting
1. Copying formula to another cell-

Step 1- Bring the mouse pointer to the bottom
right corner of the cell containing formula. We
see that the mouse pointer shape gets changed to
abasic plus sign. This is called the Fill Handle.
Step 2- Click and drag the fill handle using left
button till the cell you want to copy the formula.
A dotted line appears, which displays the
selected cells.

Step 3- Release the mouse. You will find that the
formula has been copied.

The MIN () function is used to get the smallest

[14]
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value from a set of data.

The MAX () function is used to get the largest
value from a set of data.

Two error results and their reasons-

(I) ####- The column is not wide enough to
display the number.

(11) #N/A-Dataisnotavailable.
Sorting Data-

Step 1- Select the cells in which data has to be
sorted.

Step 2- Click on the Data tab on the Ribbon.
Step 3- Click on the Sort from Sort & Filter
group.

Step 4- Select the option you want.

Step 5- Click on the OK button.

Four relational operators-

(1) =Equalto

(i1)) <>NotEqualto

(111) > Greater than

(iv) <Less than

(i1) 2. (i) 3. (iv)

(v) 5. (1)

NUMERIC

FORMULAE

OPERATORS

MS EXCEL

SORTING

In The Computer Lab
A. Do it yourself.

B. Do it yourself.
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CHAPTER-10

MORE ON E-MAIL
(iv) 2. (iii) 3. (iii)
(1) 5. (i)
(F) 2. (T) 3. (F)
(F) 5. (F)
ZIPFile
Trash
Inbox
Carbon Copy
Paper Clip

Two service providers to send and receive
emails-

(1) www.yahoo.com

(11)) www.gmail.com

It is necessary to sign out from your account to
protect your privacy.

E-mail is a way of sending messages and data to
other people by the means of a computer
connected with other computers through the
internet. Two examples of e-mail address-

(1) ranjanmohanty.ec(@gmail.com

(11) rohansethi@hotmail.com

Opening an attachment-

Step 1- Open the e-mail account and click on
the Inbox option. Click on the mail with an
attachment. You can see the e-mail opens with a
list of attached files.

Step 2- Click on Download All Attachments to
download all the attached files to the hard disk.

[16]



3.
E. 1.
4.
F. 1.
2.
3.
4.
5.

Step 3- Click on the Continue button from the
file Download Attachment box. After you click
on Continue, a File Download box gets open.
Step 4- Click on the Save button.

Step 5- A Save As dialog box appears. Select a
location where you want to save your file.

Step 6- Click on the Save button after choosing

the correct location. The file starts

downloading.

Three advantages of e-mails-

(1) It is fast and takes only a few seconds to
reach its destination.

(11) Itiscost-effective.

(111) It can be sent to any number of people at
no-extra cost.

(iv) 2. W) 3. (ii)
(i) 5. (i)

ELECTRONIC

COMPOSE

ATTACHMENT

DOWNLOAD

YAHOOMAIL

In The Computer Lab
1. Do it yourself.

2. Doityourself.
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PART-7

CHAPTER-1
COMPUTER AND ITS PARTS

A. 1. (i) 2. (i) 3. (@v)

4. (i) 5. (i)
B. 1. (1) 2. (F) 3. (F)

4. (1) 5. (D)
C. 1. Output 2. Two

3. Input 4. Computer

5. System Software
D. 1. The hardware represents all the physical units

(devices) of a computer system.

2. The term software refers to a set of sequential
instructions that are required to run or operate a
computer effectively.

3. Utility programs help the user in computer
maintenance tasks.

4. There are four kinds of hardware.

5. There are three types of programming language

translators.
E. 1. (iv) 2. (i1) 3. (i)
4. (v) 5. (D

In The Computer Lab
A. Do it yourself.
Do it yourself.
Do it yourself.

SOw

Do it yourself.

(18]



CHAPTER-2

ADVANCE FEATURES OF WINDOWS 7

O N U Y S NG NN

(i1) 2. (iii) 3. (iv)

(i1) 5. (D

(F) 2. (F) 3. (D

(F) 5. (F)

Unique 2. Titles
List 4. Size
Sortby

(1) Documents (11)  Music

(111) Videos

(1) List: This option 1s helpful for displaying
small icons followed by a list of files &
folders.

(i1) Size: This option is used to arrange files &
folders in the order of their size.

(ii1) Content: This option is used to display the
files & folders, including facts about their
name, type & size.

Step 1: Selecta file or folder

Step 2: Click on properties option in the

organize menu - Change the properties

CD Burning is the process of copying files on to
aCDROMorDVD.

Step 1: Insert CD ROM to in the CD ROM
drive.

Step 2: Click on Make Data CD.
Step 3: Click on the Add button & select the
desired files.

Step 4: Click on Next option.
[19]



Step 5: Click on the Burn option to write the
required files on the CD.

Step 6: Click on OK at the Data Disc burning
dialog box.

In The Computer Lab
A. Doityourself.

CHAPTER-3
NUMBER SYSTEM
A. 1. (i) 2. () 3. (D
4. (i) 5. (i) 35
B. 1. (F) 2. (T) 3. (B
4. (F) 5. (D)
C. 1. Octal 2. 10
3. 0 4. 16
5. bits
D. 1. Wedivide the decimal number by 2 till we get 1
as the quotient. Then, we start from the last
remainder and write all the remainders from
left to right to get the binary equivalent number.
2. Number System is a system for processing
numbers in different ways.
3. 69,~=1000101,
4. 0100010
5. 10000111
In The Computer Lab

A. Doityourself.

[20]



Test Paper-1
. (1) Graphic Tablet

(i1) Barcode scanner

(111) Joy stick

(iv) Mouse

(v) LightPen

(vi) Touchscreen

(i) 10111111111001000

(i) 110001100010111000
(i) 1111010111100110010
(iv) 1000001100010000001
(v) 11101100

(vi) 101001011101

. (1) Arithmetic Logic Unit
(11) Central Processing Unit
(111) Random Access Memory
(iv) Compact Disc-Read Only Memory

CHAPTER-4
INTRODUCTION TO C PROGRAMMING
(i) 2. (i) 3. (i)

(iii) 5. (i)

(T) 2. (F) 3. (T
(F) 5. (1)

Variable

Keywords

8

Logical

1

SNhE DD =R =k

[21]



C Language was designed and written by
Dennis Ritchie and developed by AT & T’ Bell
laboratories of USA.

C Character Set: Any alphabet, digit or special
symbol can be termed as a character. Valid
alphabets, digits & symbols allowed in C are:
Alphabets: A,B,C,...,Y,Z;ab,c,...X,y,z

Digits: 0,1,2,3,4,5,6,7,8,9

Special Symbols: ~ ' @#$%"&*() -
=N

Keywords are the words whose meaning has
already been explained to the C compiler.
Alt+F9 = to compile

Ctrl +F9 = torun

Operators are the symbols which operate on a
value or a variable.

In The Computer Lab
A. Do it yourself

B. Doityourself

C. Doityourself

A.

B.

CHAPTER-S
ADVANCED FORMULAE AND FUNCTIONS IN
MS EXCEL 2010
(iv) 2. (iii) 3. (i)

(i) 5. (i)
(F) 2. (F) 3. (T)
(F) 5. (F)

T N e A

[22]



Argument
Relative
Range
Auto Sum
Two

ol O e

Cell referencing helps to identify the behaviour
of a cell address in a formula when it is copied
from one cell to another.

2. Sorting data refers to arrangement of data on
the basis of some specified conditions.

3. Count Numbers is used for counting the
number of cells in a range of the cells
containing only numerical values.

4. AutoSum, Recently Used, Financial, Logical,
Text

5. Step 1: Click on Data tab = Filter
Step 2: Click the arrow in the column heading.
Step 3: Select Number Filters from the list.

Step 4: Click on Custom Filter from the
submenu.

Step 5: Select an option according to the
desired condition and enter a number on the
right in the Column Auto Filter dialog box

Step 6: To add another condition, click on AND
or OR.

Step 7: Apply the second condition in the same
format.

Step 8: Click on the OK button.
In The Computer Lab
A. Doityourself
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Test Paper-2

Do ityourself

Doityourself

Do ityourself

—_ N W = AN = N =

Test Paper-3
(iv) 2. (i) 3. (i)
(i) (iv)
(T) (T) 3. (F)
(F) (T)
RAM Libraries
Bits Hard Disk
Variables

DD

The term software refers to a set of sequential
instructions that are required to run or operate a
computer effectively.

CD Burning is the process of copying files on
toaCDROM or DVD.

Number System is a system for processing
numbers in different ways.

Operators are the symbols which operate on a
value or a variable.

Cell referencing helps to identify the behaviour
of a cell address in a formula when it is copied
from one cell to another.

CHAPTER-6

CHARTS IN MS EXCEL 2010

(i) 2. @) 3. (iii)
(1) 5..(D

[24]
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(F)

(T)

Items

Chart

Ctrl+P

The main components of a chart include Plot

Area, Value Axis, Category Axis, Data Points,

Chart Area and Legend.

Three types of charts in MS Excel-

(1) Column Chart

(i) PieChart

(ii1) Bar Chart

The shortcut key to print a chart or a worksheet

is Ctrl +P.

Advantages of representing data in Charts and

Graphs-

(1) Data can be represented in an attractive
manner.

(T) 3...(D
(T)

Interconnected

sl e

Two

(i1) These are easier to understand and recall.

Ctrl + F2 is the keyboard shortcut for
displaying the print preview ofa chart.

In The Computer Lab
A. Doityourself.

A.

I.
4.

CHAPTER-7
INTRODUCTION TO HTML
(ii) 2. (ii) 3. (iii)
(i) 5. (D)

[25]
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(F) 2. (D) 3. (F)

(T) 5. (F)

Text 2. Servers
Web browser 4. Document
Web pages

Features of HTML-

(1) HTML documents are simple text files.

(11)) HTML s not a case sensitive language.

The internet means interconnected network.
Creating HTML document-

Step 1- Open Notepad; type the HTML code.
Step 2- Click on the File menu = Save. We see
the Save As dialog box.

Step 3- Choose the folder where file is to be
saved and type a file name followed by
extension .htm or .html

Step 4- Click on Save button.

The tool required to create an HTML document
is Notepad. The tools required to view are
Internet Explorer, Mozilla Firefox, Opera, etc.

Web Browser is used to view and display the
HTML documents. Internet Explorer, Mozilla
Firefox and Chrome are few examples of web
browsers.

Hyper Text Markup Language

World Wide Web

Dynamic Hypertext Markup Language
Extensible Markup Language

American Standard Code for Information
Interchange

[26]



F. 1. WEBSITES
2. CONTAINER
3. ATTRIBUTES
4. DOCUMENTS
5. HYPERTEXT
In The Computer Lab

A. Doityourself
B. Doityourself

R

CHAPTER-8
HTML- CREATING WEBPAGES
(1) 2. (1) 3. (i)
(i1) 5. (i)
(T) 2. (B 3. (D)
(T) 5. (T)
<HR>
<MARQUEE>
<p>
Compiler
<OL>

Not more than three headers at a time can be

used ina web page.

<BR> tag is used for beginning a new line in

HTML.

Horizontal rules are simple horizontal lines
that are spread across the width of the screen or

web page.
Adding comments in a program-

[27]



Step 1- Type <!
Step 2- Type the required comments
Step 3- Type>

5. Moving or scrolling text can be placed in a web
page by using the <MARQUEE> tag.
E. 1. (i)
2. (iii)
3. (v)
4. (1)
5. (iv)
In The Computer Lab
A. Doityourself
B. Doityourself
Test Paper-4
A. Doityourself.
B. Doityourself.
CHAPTER-9
COMPUTER VIRUS
A. 1. () 2. (i) 3. (i)
4. (1) 5. (i)
B. 1. (F) 2. (B 3. (D
4. (F) 5. (T)
C. 1. DiskDirectory
2. Polymorphic
3. Slow Infector
4.  Multipartite
5. Metamorphic

[28]



5.

i

Computer virus is a program that is created
intentionally to corrupt or delete data stored in
a computer by erasing information available
on its hard disk.

An anti-virus software is used for detecting,
repairing and removing virus-infected files
from a computer.

Viruses infect the programs and functions such
as start-up and shut down.

Sources of virus-

(1) Floppy Disks

(11) Internet

(ii) E-mail

(iv) Computer Network
Symptoms of virus-

(1) Programs acterratically.
(i) Program sizes keep altering.
(i1)

(iv)

v)

(iii)

(1)

In The Computer Lab
A. Doityourself.

B. Doityourself.
C. Doityourself.

[29]



CHAPTER-10

INTRODUCTION TO FLASH
A. 1. (iv) 2. (1) 3. (i)
4. (iv) 5. ()
B. 1. (1) 2. (D 3. (F)
4. (F) 5. (F)
C. 1. Width
2. Commands
3. Penciltool
4. Two
D. 1. Flash is used for creating animations which
may consist of images, sound, video and
animation effects.
2. Theextensionofaflash fileis ‘.fla’
3. Fourways of working of free transform tool-
(I) Distort
(i) Scale
(iii) Rotate and Skew
(iv) Envelope
4.  The Property Inspector is a panel that displays
the properties of the selected object.
5. Texttool enables the user to add text.
In The Computer Lab

A. Doityourself.

B. Doityourself.

Test Paper-5

A. Doityourself.
B. (i) Eyedropper
(i) Eraser

[30]



(iii) Ink Bottle

(iv) Zoom
(v) Painter Bucket
(vi) Lasso
Test Paper-6
1. () 2. (i) 3. ()
4. (1) 5. ()
I. () 2. (F) 3. (F)
4. () 5. (1)
1. TItems
2. HTML
3. Anchor
4.  Anti-virus
5. Flash
1. Advantages of representing data in charts and

Graphs-

(1) Data can be represented in an attractive
manner.

(i1) They are easier to understand and recall.

2. Individual computer systems are connected to
a powerful computer system. These powerful
computers are called servers.

3. Moving or scrolling text can be placed in a web
page by using the Marquee text.

4. Computer virus is a program that is created
intentionally to corrupt or delete data stored in
a computer by erasing information available
onits hard disk.

5. The Property Inspector is a panel that displays
the properties of the selected object.

[31]



A.

B.

L.

PART-8

CHAPTER-1
COMPUTER HARDWARE AND SOFTWARE
(111) 2. (i) 3. (i)
(111) 5. (iii)
(F) 2. (D) 3. ()
(T) 5. (F)
Hardware
ALU
Software
File
Database

e O el i

Plotter is an output device used to make large
paper drawings like maps and engineering
drawings.

The three units of CPU are Arithmetic Logic
Unit, Control Unitand Memory Unit.

A Database refers to collection of all files in an
organization.

Detecting the problem and solving it to make a
computer work properly is called
troubleshooting.

The two types of software in a computer system
are System Software and Application
Software.
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CHAPTER-2

INTRODUCTION TO MICROSOFTACCESS 2010

A.

B.

1.

R e

(1) 2. (i) 3.(D
(1ii) 5. (iv)

(F) 2. () 3.(T)
(F) 5. (1)
Tables 2
Records 4

Form
Fields

Manipulation

Database refers to a collection of related tables
containing organised data.

Relational Database Management System
Three advantages of maintaining a database
are:

(i) Reduction ofdataredundancy

(i) Easyretrieval of data

(ii1) Easy sharing of data

Aprimary key is used to relate a table to another
key in other tables.
Four views for working with a table in MS
Access:

(1) Datasheet View

(i) PivotTable View

(ii1) Pivot Chart View

(iv) Design View

In The Computer Lab
A. DoitYourself
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Test Paper-1
A. (1) Dot-Matrix Printer
(11) Inkjet Printer
(111) Laser Printer
(iv) Drum Plotter
(v) Drawing Tablet

(vi) MICR
B. (i) I (i) S (iii) I
(iv) S (v) O (vi) O
C. Doityourself.
CHAPTER-3
MS ACCESS: QUERIES, FORMS AND REPORTS
A. 1. (i) 2. (i) 3. (D
4. (iii) 5. (i)
B. 1. (F) 2. (B 3. (B
4. (1) 5. (D)
C. 1. Criteria
2. Sort
3. Database
4. Form
5. Layoutview
D. 1. A query in MS- Access produces selected

records from a table that meets certain pre-
defined conditions.

2. Itis used to choose a style from the gallery in
the layout view.

3. Thenavigation bar is used to access the records
ona form.

4.  The three views available in MS access to view

aform are-
[34]



1) Form view 1i) Layout view iii) Design view

5. Creating query in MS Access-

1) Openadatabase and click on Create.

1) Click on Query design in the Queries
group. You’ll see the Show table dialog
box.

iii) Selectatable where query has to be placed.

iv) Click on Add. The selected table is added
in the query window.

v) Clickon Close.

In The Computer Lab
Do it Yourself
CHAPTER-4
MORE ABOUT FLASH
A. 1. (i) 2. (1) 3. (@)
4.  (iii) 5. (i)
B. 1. (F) 2. (T) 3. (F)
4. (F) 5. (F)
C. 1. Librarypalette
2. Keyframe
3. Expansion
4. Required
5. Current frame
D. 1. Asymbol helps us in creating animations in an

easier way and also helps in avoiding
unnecessary expansion of the file size. The
three types are— graphics, buttons and movie
clips.
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1) Selectthe object by clicking on it.

i1) Click on Convert to symbol in the Modify
menu.

1) A dialog box appears. Type the desired
name and select the type.

iv) Click on OK.

Akey frame is the frame on which you work to

make a change in the content.

i) Click on the frame below the number
where you want to insert the frame.

i1) Click on the timeline under the insert
menu.

iii) Select one frame.

1) Select the frame you want to delete from
the timeline panel.

i1) Right-click on the selected frame and click
onremove frames.

CHAPTER-5
INTRODUCTION TO C++
(ii) 2. (i) 3. (iii)
(ii) 5. (iii)
(T) 2. (F) 3. (T)
(T) 5. (1)
Spaces
Char
Underscore
Constant
Assignment
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D. 1. FloatandInt
2. (2*4+6)/10
(a*b*c)/2
3. C++is a high-level programming language. It
can easily handle large programs to meet the
growing software requirements.
4. Datatypes- int, char, float
Operators- arithmetic, relational and logical
operators
5. Fornaming variables-
(I) C++ is case sensitive but both small and
capital letters can be used.
(i1) First character must be an alphabet or an
underscore.
(ii1) Digits between 0-9 can be used but the
variable can’t start with these variables.

(iv) No spaces are allowed between a variable
name.

(v) Nosymbol other than an underscore can be
used.

(vi) Variable name can be as long as you like
but only first two characters are
recognised.

(vii) The predefined keywords of C++ can’t be
used.

In The Computer Lab
Do ityourself
Test Paper-2
Do ityourself
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CHAPTER-6

FOR LOOP IN C++
A. 1. (i) 2. (iii) 3. (i)
4. (1) 5. (iii)
B. 1. (1) 2. (F) 3. (1)
4. (1) 5. (F)
C. 1. Zero
2. Condition
3. Loops
4.  Assignment
5. Accumulator
D. 1. Loops are used to execute a set of statements a
certain number of times.
2. Forloop, do.....while loop and while loop.
3. For (initialization; test-condition; increment or
decrement)
{ o Sequence of statements }
4. Itis a variable which stores the sum or product
of many numbers.
5. Whenaloop is inserted inside a loop it is called
anested loop.
In The Computer Lab
Do ityourself
CHAPTER-7
First Few Steps In Java
A. 1. (ii) 2. (iv) 3. (i)
4. (iii) 5. (iii)
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(F) 2. (T) 3. (1)

(F) 5. (F)

Literal

Comments

If

[teration

Double

Programs written in Java are compiled into a

byte code which is then interpreted by a special

Java interpreter for a specific platform. This

Javainterpreter is called Java Virtual Machine,

The machine language for Java Virtual

Machine is called as Java byte code.

Identifiers are fundamental building blocks ofa

program. They are used as the general

terminology for the names given to various

parts of the program, viz, variables, objects,

etc.

The rules for Java Identifiers are:

(i) They can have alphabets, digits,
underscore and dollar sign.

(i1)) They must not be a keyword or Boolean
literal or anull literal.

(ii1) They must not begin with a digit.

(iv) They canbe of any length.

(v) Java is a case sensitive language, i.e.,
upper case and lower case characters are
treated differenty.

[39]



if (condition)

{

Statement 1;

}

Switch case statement is used to check one
condition at a time.

In The Computer Lab
A. Doityourself

e A e

CHAPTER 8

Networking of Computers
(1) 2. (i) 3. (i)
(1) 5. (1)
(T) 2. (D 3. (F)
(F) 5. (D)
Co-axial
Server
LAN
Fibre Optic
Data

The different types of cables used in computer
networking are :-

(1) Twisted Pair Cables

(i1) Co-axial Cables

(ii1) Fibre Optic Cables

The two advantages of ring topology network
are :-

(1) It is easy to locate cable faults, thus
troubleshooting is easier.
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(11) Itiseasytoinstallaring topology network.
The configuration in which workstations of a
network are connected is called a topology.

It’ the logical layout or geometric structure of a

network. Various types of topologies are :-

(1) RingTopology

(i) BusTopology

(ii1) Star Topology

(iv) Tree Topology

The advantages of networking are as follows—

(1) It helps in sharing of useful information
and data.

(i) It helps in sending files from one
computer to another.

(ii1) Itdelivers dataata fast speed.

(iv) Thereis higher reliability.

(v) It helps in storing files in a centralised
system, which makes them accessible to
anyone on the network.

(vi) Itis the perfect solution for satisfying the
business needs of a computer.

(vii) The PCs on the network (intelligent
networks) can process the data on their
own.

(viii) Passwords can be established for specific
directories so that only authorised people
can access the data.

Networking is the interconnection of various

computers to share their data and information.

It is the connection of cables through which

[41]



two or more computers share data and
information. It is done with help of cables,

LAN cards, modems etc.

In The Computer Lab
A. Doityourself
B. Doityourself
Test Paper-3
A. Doityourself
B. 1. StarTopology
2. RingTopology
3. BusTopology
4. Tree Topology
CHAPTER 9
Computer Virus & its Detection
A. 1. (i) 2. (iii) 3. (iii)
4. (i) 5. ()
B. 1. (F) 2. (D 3. (F)
4. (F) 5. (T)
C. 1. Bomb
2. AVG
3. Files
4. Speed
5. Avast
D. 1. Anti virus is a program used to detect and
remove virus.
2. Norton, McAfee, AVG, Avast
3. Most of the virus programs are used to confuse

and irritate the operators. But other viruses can

[42]



prove to be very harmful to a computer system
as they can modify or corrupt files, delete data,
steal passwords, etc.

Routes Of Virus Attacks:

E-mail, infected pen drive or CD,
Downloading infected files, starting an
infected application.

Computer virus doesn’t damage keyboard and
monitor.

Bomb : Gets activated after a particular time
and causes damage to the computer system.
Boot sector virus: These are very risky as they
harm the boot sector part of a hard disk or
floppy disk.

E-mail virus: These enter the computer when
an infected email or its attachment is opened.
Trojans: These can destroy data of a computer
system and appear in the form of infected
computer videos, games, etc

Worms: These make a copy of themselves and
spread everywhere to affect the speed of a
computer.

In The Computer Lab
A. Doityourself

B. Doityourself

A.

1.
4.

CHAPTER-10
Exploring The Internet
(1i1) 2. (i) 3. (iv)
(1i1) 5. (iv)
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B. 1. (F) 2. (F) 3. (T)
4. (F) 5. (1)
C. 1. B2B
2. Commerce
3. B2C
4.  Producer
5. Video Conferencing
D. 1. E-commerce is a term that refers to the process

of buying and selling of products online using
internet technologies.

2. Electronic Data Interchange (EDI) is a term
used for the system of accepting payments for
online transactions. These payment system
includes credit card, debit card, mobile
payments, e-cash, etc.

3. Video conferencing enables two or more
people sitting at different places to talk and see
each other. This is often used by big corporates
and tv shows. It is a unique platform for
communication.

4. Facebook, Twitter, Instagram

5. Peopleinvolved in E commerce:

Producers, sellers and buyers.
In The Computer Lab
A. Doityourself
B. Doityourself

CHAPTER-11
Computer Ethics, Crime And Security
A. 1. (i) 2. (i) 3. (i)
4. (i) 5. ()
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(T) 2. (F) 3. (F)
(T) 5. (F)

Illegal

Software

Copyright

Warranty

Security

It refers to illegal copying and distribution of
commercial copyrighted software without
paying for it.

2. Hacker is a person who breaks into the
computer system to get invalid exposure to
confidential data and information.

e o e

3.  Online auction piracy refers to the sale of
software that is not authorised for resale.
Pirated software don’t contain warranty and
usually contain viruses that can harm our
computer.

4. Pre-Installed software piracy refers to invalid
installation of a computer software on multiple
systems by a manufacturer.

5. Crackeris a person who breaks into a computer
system to use passwords, files or programs
illegally.

In The Computer Lab
A. Doityourself
B. Doityourself
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